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ВСТУП 

 

Сучасна хімічна наука давно уже не є суто експериментальною, як це 

було в часи Кавендиша, Ле Шательє або Шеєле. Науковий пошук вчених-

хіміків спрямований сьогодні на виявлення найуніверсальніших 

закономірностей хімічних процесів та застосування цих закономірностей для 

ряду реакційних систем. Важко уявити собі сучасний науковий колектив, який 

починає експеримент, не маючи жодної уяви про його ймовірний результат. 

Комп’ютерне моделювання є потужним інструментом прогнозування 

хімічних процесів, виявлення взаємозв’язку між параметрами і 

характеристиками реакційних систем, дослідження хімічних реакцій на 

молекулярному рівні, встановлення механізмів реакцій, наочного 

представлення хімічних взаємодій і виконання складних розрахунків для 

точного математичного опису реакцій.  

Успішне проведення модельного (обчислювального) експерименту 

вимагає від дослідника знань з математики, фізики, основ інформатики. 

Спеціалізовані програми для комп’ютерного хімічного моделювання 

створюються колективами професіоналів з різних галузей науки. Однак 

фундаментальне уявлення про математичну модель того чи іншого процесу 

має бути саме у хіміка. Завдяки цьому з’являється можливість моделювання 

хімічних процесів в універсальніших, не призначених безпосередньо для цієї 

задачі програмах.  

У цьому навчальному посібнику розглянуто завдання, з якими більшість 

дослідників-хіміків зустрічається у процесі наукової роботи. Представлено 

методику встановлення та обробки одно- і багатопараметрових кореляційних 

залежностей методами регресійного аналізу, що має практичне застосування у 

визначенні реакційної здатності речовин, співвіднесенні кінетичних та 

термодинамічних характеристик хімічних сполук з параметрами будови. 

Наведено способи візуалізації хімічних формул та рівнянь реакції, що є 
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необхідною для коректного і наочного представлення результатів 

експерименту. Описано алгоритм оптимізації молекулярної геометрії та 

розрахунку особливих точок поверхні потенціальної енергії для планування 

експерименту та теоретичного дослідження механізму хімічних реакцій. 

Запропоновано методику моделювання необоротних та оборотних процесів 

для встановлення кінетичних закономірностей хімічних реакцій. 

Наведені методики опрацювання таких завдань мають практичну 

цінність для планування експерименту, обробки та інтерпретації емпіричних 

даних, отриманих у будь-якій галузі хімічної науки. Автор сподівається, що 

практичні навички, здобуті студентами у процесі виконання лабораторних 

робіт за цим посібником, знайдуть застосування у підготовці курсових і 

кваліфікаційних робіт.  
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ПРОГРАМА КУРСУ 

 

Змістовий модуль 1. Математичне моделювання: 

Місце моделювання в теорії пізнання. Моделі-уявлення у становленні 

науки. Моделювання в хімії. Модель. Класифікація моделей. Символьні та 

графічні моделі в хімії. 

Сфери застосування математичного моделювання. Основні аспекти 

математичного моделювання. Формальний аспект математичної моделі. 

Поняття змінної, фактора, параметра. Форми представлення змінних. 

Класифікація математичних моделей. Моделі типу “біла”, “сіра” та 

“чорна скринька”. Етапи побудови математичної моделі. Моделі типу 

структура – властивість. QSAR у теорії реактивності. Екстратермодинамічні 

моделі. Дескриптори. Побудова моделей структура – властивість.  

Змістовий модуль 2. Квантовохімічні методи в моделюванні: 

Теоретичні засади квантовохімічних моделей. Моделі типу “біла 

скринька”. Наближені методи. Методи обчислень багатоатомних молекул.  

Методи MINDO/3, MNDO, AM1, PM3. Пакети квантовохімічних 

програм. Інтерпретатори та візуалізатори результатів обчислень. 

Бімолекулярні реакції. Дані, необхідні для розрахунку констант 

рівноваги та швидкості. Візуалізація структур і шляхи процесу. Визначення 

термодинамічних і кінетичних параметрів елементарних реакцій на основі 

квантовохімічних розрахунків.  

Змістовий модуль 3. Моделювання складних реакцій: 

Типи складних реакцій. Механізм реакції. Пряма і зворотна кінетичні 

задачі. Моделювання каталітичних і фотохімічних процесів.  

 

  



Комп’ютерне моделювання хімічних процесів 
 

6 
 

1. ЛАБОРАТОРНІ РОБОТИ 

 

1.1. Побудова моделі лінійної однопараметрової кореляції 

 

1.1.1. Теоретична частина 

Кореляція – це статистичний взаємозв’язок двох або кількох випадкових 

величин (або величин, які можна з деяким допустимим ступенем точності 

вважати такими). Водночас зміна значень однієї чи кількох із цих величин 

супроводжується систематичною зміною значень тієї чи іншої величин.  

Математичне рівняння, яке оцінює лінію простої (парної) лінійної 

кореляції: 

y = mx + b, (1.1.1)

де x називається незалежною змінною чи предиктором; y – залежна змінна чи 

змінна відгуку; m – кутовий коефіцієнт чи градієнт оціненої лінії; вона являє 

собою величину, на яку y збільшується в середньому, якщо ми збільшуємо x на 

одну одиницю; b – вільний член (перетин) лінії оцінки; це значення y, коли x = 0. 

Коефіцієнт кореляції (r Пірсона) характеризує наявність лінійної 

залежності між двома величинами. Коефіцієнт кореляції може приймати 

значення від –1 до +1. Чим ближче абсолютне значення r Пірсона до 1, тим 

сильнішим є зв’язок між двома випадковими величинами. Статистично 

значимими вважаються дані, для яких r ≥ 0,95. Коефіцієнт кореляції r приймає 

позитивні значення при прямій залежності між величинами, коли збільшення 

незалежної змінної приводить до збільшення залежної змінної, а негативні – 

при зворотній залежності, коли збільшення x призводить до зменшення y. 

Коефіцієнт детермінації (r2) показує долю варіації (дисперсії) залежної 

змінної, що врахована у моделі й обумовлена впливом факторів, включених у 

модель. Величина r2 лежить в діапазоні від 0 до 1 і чисельно дорівнює величині 

коефіцієнта кореляції, взятій у квадраті. Чим ближче значення r2 до 1, тим 

сильніша залежність між змінними. 
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Залишкова сума квадратів – метод оцінки різниці між даними та 

оціночною моделлю. У разі сильної кореляції величина залишкової суми 

квадратів наближається до 0. 

Стандартне відхилення – показник розсіювання значень випадкової 

величини стосовно її математичного очікування – середнього значення 

випадкової величини. Стандартне відхилення можна вважати мірою 

невизначеності даних. Значення стандартного відхилення для сильної кореляції, 

здебільшого, помітно менше за значення самих випадкових величин. 

Середнє значення y – сума усіх значень y, поділена на їх кількість. 

Медіана – величина y, що знаходиться посередині ранжованого 

варіаційного ряду. Рівно половина елементів вибірки мають значення, більші 

за цю величину, а інша половина – менші за неї.  

Програмний пакет Origin Pro – професійний інструмент для 

математичного аналізу даних і створення наукової графіки (рис. 1.1.1).  

 

Рис. 1.1.1. Вигляд робочого вікна програми Origin Pro 2015 

 

1.1.2. Методичні вказівки 

Для отримання графічного представлення лінійної однопараметрової 

кореляції в Origin Pro 2015 необхідно ввести відомі значення x та y у відповідні 
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колонки у вікні програми: A(X), B(Y), виділити колонки та обрати меню 

Plot → Scatter. Графік буде мати точковий вигляд. 

Для статистичної обробки параметрів лінійної кореляції варто обрати 

вікно Graph → меню Analysis → Fitting → Linear Fit. В діалоговому вікні 

поставити галочки на пунктах:  

 Value (значення параметрів кореляції);  

 Number of Points (кількість точок);  

 Residual Sum of Squares (залишкова сума квадратів);  

 Pearson’s r (коефіцієнт кореляції);  

 Adj. R–Square (коефіцієнт детермінації);  

 Standard Error (середньоквадратична похибка).  

Водночас на графіку з’являється лінія тренду. Для статистичної обробки 

значень y варто виділити стовпчик, що містить ці значення, далі обрати кнопку меню 

Statistics → Descriptive Statistics. В діалоговому вікні поставити галочки на пунктах: 

 Standard Deviation (стандартне відхилення y);  

 Mean (середнє значення);  

 Sum (сума);  

 Minimum (мінімум);  

 Maximum (максимум);  

 Median (медіана). 

1.1.3. Експериментальна частина 

Мета роботи: використання однопараметрових рівнянь лінійної кореляції 

для опису хімічних реакцій та освоєння методики їх статистичної обробки. 

 

Завдання для лабораторної роботи: 

1. На основі даних експерименту (отримати у викладача) побудувати 

графічне представлення лінійної однопараметрової кореляції у програмному 

пакеті Origin Pro 2015. 

2. Отримати рівняння прямої, виходячи з експериментальних даних. 

Занести рівняння у табл. 1.1.1. 
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3. Провести статистичну обробку параметрів лінійної кореляції. 

Кореляційні параметри занести у табл. 1.1.1. 

4. Провести статистичну обробку значень y. Кореляційні параметри 

занести у табл. 1.1.1. 

 

Таблиця 1.1.1. Модель лінійної однопараметрової кореляції для 

хімічного експерименту 

Назва експерименту 
 
 
 

Рівняння лінійної кореляції  
Кількість точок  
Коефіцієнт кореляції (r Пірсона)  
Коефіцієнт детермінації (r2)  
Залишкова сума квадратів  

Середньоквадратична похибка 
m b 
  

Стандартне відхилення y  
Середнє значення y  
Сума y  
Мінімальне значення y  
Максимальне значення y  
Медіана  

 

5. У висновках до роботи оцінити статистичну значимість 

експериментальних даних по результатах моделювання. 

 

1.1.4. Питання для самоконтролю 

1. Що називається кореляцією? 

2. Які статистичні параметри характеризують кореляцію? 

3. При якому значенні r Пірсона вважається, що між двома випадковими 

величинами існує статистично значима кореляція?  

4. Що таке лінія тренду? 

5. Наведіть приклади лінійних однопараметрових кореляцій у хімії.
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1.2. Побудова моделі множинної регресії 

 

1.2.1. Теоретична частина 

Множинний регресійний аналіз – це метод встановлення залежності 

однієї змінної від двох або більше незалежних змінних. Рівняння для 

множинної регресії має такий вигляд: 

y = m1x1 + m2x2 +... + b, (1.2.1)

Якщо існує кілька діапазонів значень x, де залежні значення y – функції 

незалежних значень x. Значення m – коефіцієнти, які відповідають кожному 

значенню x, а b – постійна. 

Програмний пакет Origin Pro надає безліч функцій для статистичної 

обробки даних різної складності, включаючи метод ANOVA. 

ANOVA (з англ. ANalysis Of VAriance – дисперсійний аналіз) – 

статистичний метод, який оцінює потенціальні відмінності в середніх 

значеннях. ANOVA, розроблений Рональдом Фішером у 1918 році для аналізу 

результатів експериментальних досліджень, на відміну від t-критерію, дає 

змогу порівнювати середні значення трьох і більше груп. Цей аналіз також 

називається дисперсійним аналізом Фішера. Дисперсійний аналіз може бути 

поділений на кілька видів: 

 одномірний (одна залежна змінна) і багатомірний (кілька залежних 

змінних); 

 однофакторний (одна групуюча змінна) і багатофакторний (кілька 

групуючих змінних) з можливою взаємодією між факторами; 

 з простими вимірами (залежна змінна вимірюється лише один раз) і з 

повторними (залежна змінна вимірюється кілька разів). 

Програма Microsoft Excel є частиною програмного пакету Microsoft 

Office і являє собою табличний процесор для математичної, статистичної 

обробки і графічного представлення даних. Обробка множинної регресії в 

Microsoft Excel здійснюється за допомогою функції ЛИНЕЙН. Ця функція 
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розраховує статистику для ряду із застосуванням методу найменших 

квадратів, щоб розрахувати пряму лінію, яка якнайкраще апроксимує наявні 

дані та потім повертає масив {mn;mn-1;...;m1;b}, який описує отриману пряму. 

Оскільки повертається масив значень, функція має задаватися у вигляді 

формули масиву. Функція ЛИНЕЙН також повертає додаткову регресійну 

статистику (табл. 1.2.1, рис. 1.2.1). 

Число ступенів свободи – кількість значень у підсумковому обчисленні 

статистики, що здатні варіюватись. 

F-статистика – критерій, що оцінює загальну значимість моделі. 

Величина F-критерію для експериментальних даних порівнюється із 

довідниковими табличними даними (див. Об’єкти для моделювання, 

Лабораторна робота 1.2): F(p, f1, f2), де p – рівень значимості, тобто ймовірність 

набуття випадковою величиною того чи іншого значення (наприклад, 0,05),  

f1 – кількість незалежних змінних у рівнянні регресії, f2 – число ступенів 

свободи, що дорівнює n – f1 – 1, де n – число спостережень.  

Якщо F > F(p, f1, f2), то при заданому рівні значимості модель вважається 

статистично значимою. Якщо F ≤ F(p, f1, f2), то модель є незначимою.  

 

Таблиця 1.2.1. Додаткова регресійна статистика функції ЛИНЕЙН 

Величина Опис 
se1, se2, 
..., sen 

Стандартні значення похибок для коефіцієнтів m1, m2, ..., mn 

seb 
Стандартне значення похибки для постійної b (seb = #Н / Д, 

якщо аргумент конст має значення ЛОЖЬ) 
r2 Коефіцієнт детермінації 
sey Стандартне відхилення для оцінки y 
F F-статистика або F-спостережуване значення 
df Ступені свободи 

ssreg Регресійна сума квадратів 
ssresid Залишкова сума квадратів 
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Рис. 1.2.1. Порядок повернення додаткової регресійної статистики при 

виконанні функції ЛИНЕЙН у програмі Microsoft Excel 

 

1.2.2. Методичні вказівки 

Для статистичної обробки множинної регресії у програмному пакеті 

Origin Pro 2015 необхідно вибрати меню Analysis → Fitting → Multiple Linear 

Regression. В діалоговому вікні поставити галочки на пунктах:  

 Value (значення параметрів регресії); 

 Standard Error (середньоквадратична похибка);  

 Number of Points (кількість точок);  

 Degrees of Freedom (кількість ступенів свободи);  

 Residual Sum of Squares (залишкова сума квадратів);  

 R-Square(COD) (коефіцієнт детермінації r2);  

 Root-MSE (SD) (стандартне відхилення y);  

 ANOVA (регресійна сума квадратів). 

Для введення даних у вигляді масиву в програмі Microsoft Excel 

потрібно виділити такий діапазон комірок, у якому кількість стовпців 

дорівнює загальній кількості залежних і незалежних параметрів (x та y), а 

кількість рядків, з огляду на вигляд повернення додаткової регресійної 

статистики (рис. 1.2.1), дорівнює п’яти.  

Синтаксис функції ЛИНЕЙН у Microsoft Excel: 

ЛИНЕЙН ([відомі_значення_y]; [відомі_значення_x]; [конст]; [статистика]) 

 Відомі_значення_y. Множина значень y із співвідношення y = m1x1 + 

+ m2x2 + ... + b. 

 Відомі_значення_x. Множина значень x із співвідношення y = m1x1 + 

+ m2x2 + ... + b. 
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 Конст. Логічне значення, яке вказує, чи потрібно, щоб константа b 

дорівнювала 0. 

o Якщо аргумент конст має значення ИСТИНА або пропущений, то 

константа b ≠ 0 й обраховується як зазвичай. 

o Якщо аргумент конст має значення ЛОЖЬ, то значення b вважається 

рівним 0. 

 Статистика. Логічне значення, яке вказує, чи потрібно повернути 

додаткову регресійну статистику у вигляді, вказаному на рис. 1.2.1. 

o Якщо аргумент статистика має значення ИСТИНА, 

функція ЛИНЕЙН повертає регресійну статистику.  

o Якщо аргумент статистика має значення ЛОЖЬ або пропущений, 

функція ЛИНЕЙН повертає тільки коефіцієнти m і постійну b. 

Важливо! Для того, щоб Microsoft Excel розпізнав дані як масив, 

введення даних треба підтвердити комбінацією клавіш 

CTRL+SHIFT+ENTER. 

1.2.3. Експериментальна частина 

Мета роботи: використання рівнянь множинної регресії для опису 

хімічних реакцій, які залежать від кількох факторів, та освоєння методики їх 

статистичної обробки. 

Завдання для лабораторної роботи: 

1. Внести дані експерименту (отримати у викладача) в програмний 

пакет Origin Pro 2015: залежні параметри (функцію) – в колонку A, незалежні 

параметри (фактори) – в колонки B, C, D. 

2. Провести кореляційний аналіз множинної регресії за допомогою 

функції “Multiple Linear Regression”. Занести розраховані кореляційні 

параметри у таблицю 1.2.2. 

3. Повторити введення тих самих даних та їх кореляційний аналіз у 

програмі Microsoft Excel, використовуючи функцію “ЛИНЕЙН” у вигляді 

формули масиву. Занести розраховані кореляційні параметри у табл. 1.2.2. 
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Таблиця 1.2.2. Модель множинної регресії для хімічного експерименту 

 Origin Pro 2015 Microsoft Excel 
Параметри множинної 
регресії 

b m1 m2 m3 b m1 m2 m3 
        

Середньоквадратична 
похибка 

    
    

Рівняння множинної 
регресії 

 
 

Кількість точок   
Число ступенів свободи   
Коефіцієнт детермінації 
(r2) 

 
 

Стандартне відхилення y   
Критерій Фішера F   
Регресійна сума квадратів   
Залишкова сума квадратів   

 

4. Порівняти результати кореляційного аналізу, отримані в Origin Pro 

2015 і в Microsoft Excel.  

5. Зробити висновок про статичну значимість експериментальних даних 

за результатами моделювання, а також вказати й обґрунтувати, яка із двох 

використаних програм, на Ваш погляд, є найзручнішою для кореляційного 

аналізу множинної регресії. 

1.2.4. Питання для самоконтролю 

1. Що таке множинний регресійний аналіз? 

2. Охарактеризуйте метод ANOVA. 

3. Як визначається статистична значимість кореляції за F-критерієм? 

4. Якою комбінацією клавіш підтверджується введення даних у вигляді 

масиву у програмі Microsoft Excel? 

5. Наведіть приклади множинних регресій у хімії. 
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1.3. Візуалізація молекулярних структур  

 

1.3.1. Теоретична частина 

Програма ChemDraw входить до складу пакету ChemOffice і призначена 

для візуалізації молекулярних структур. За її допомогою можна відображати 

молекулярні структури різного складу та розміру, деякі біологічні структури 

(наприклад, мембрани клітин, схематичні фрагменти ДНК та РНК), хімічне 

обладнання тощо. У програмі також наявна можливість генерування назви 

молекулярної структури згідно із правилами ІЮПАК, запису й редагування 

рівнянь хімічних реакцій тощо. 

Панель інструментів, що знаходиться у лівій частині головного вікна 

програми (рис. 1.3.1), безпосередньо призначена для зображення 

молекулярних структур. Для цього вона надає широкий вибір можливостей, 

починаючи від поступової побудови молекул з простих елементів (атомів та 

зв’язків) і закінчуючи можливістю використання з цією метою готових 

структур чи їх ключових фрагментів (рис. 1.3.2).  

 

 

Рис. 1.3.1. Вигляд робочого вікна програми ChemDraw Ultra 12.0 
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Рис. 1.3.2. Приклади шаблонів готових структур і лабораторного 

устаткування у програмі ChemDraw Ultra 12.0 

 

Функції основних кнопок на панелі інструментів ChemDraw: 

 Lasso  і Marquee  – виділення молекулярних структур та їх 

фрагментів; 

 Група кнопок Bonds        – додавання різних 

хімічних зв’язків;  

 Eraser   – видалення окремих атомів і зв’язків; 

 Text  – введення тексту (параметри шрифту та індексація 

налаштовуються за допомогою головної панелі);  

 Pen Tools  – увімкнення режиму малювання згладженої ломаної лінії;  

 Arrow Tools  – додавання до робочої області стрілок різного 

вигляду і форми; 

 Orbital Tools  – відображення у робочій області електронних 

орбіталей різних форм і видів;  

 Drawing Tools  – набір графічних елементів (пласких та об’ємних 

сфер, прямокутників, ліній тощо); 

 Bracket Tools  – набір дужок різного вигляду;  
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 Chemical Symbol Tools  – набір особливих хімічних символів 

(заряди іонів, значки радикалів тощо);  

 Chain Tools  – інструмент для зображення нециклічних ланцюгів 

(число ланок ланцюга при зображенні показує спеціальний індикатор);  

 Templates – шаблони різних структур та об’єктів: амінокислот, 

ароматичних циклів, біциклів, зображень хімічних приладів і посуду, 

функціональних груп тощо; 

 Rings           – група кнопок для 

швидкої вставки до робочої області таких фрагментів молекулярних структур, 

як циклоалкани й ароматичні цикли.  

Меню кнопок зі стрілкою в куточку викликається натисканням й 

утримуванням такої кнопки. 

1.3.2. Методичні вказівки 

Побудова молекулярних структур здійснюється за допомогою групи 

кнопок Bonds, а також Rings та Templates.  

Для виклику вікна з періодичною системою варто обрати меню View → 

Show Periodic Table Window.  

Для отримання назви структури за номенклатурою IUPAC необхідно 

виділити об’єкт за допомогою кнопок Lasso  або Marquee  й обрати меню 

Structure → Convert Structure to Name.  

Для визначення молекулярної маси молекули необхідно виділити об’єкт 

за допомогою кнопок Lasso  або Marquee  й обрати меню View → Show 

Analysis Window.  

Форматування текстових елементів (шрифт, розмір, колір) здійснюється 

за допомогою панелі інструментів Style. Якщо вона відсутня у вікні програми, 

варто обрати меню View → Show Style Toolbar. 
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Додавання заряду здійснюється кнопкою Chemical Symbol Tools  з 

випадаючим меню. При зміні заряду автоматично змінюється оточення атому 

(кількість атомів Н) з урахуванням його ймовірної валентності.  

Зміна кратності зв’язку виконується за допомогою кнопки Multiple 

Bonds . Також можна послідовно перетворити одинарний зв’язок на 

подвійний та потрійний натисканням по ньому кнопкою Solid Bond . 

Видалити зайві кратні зв’язки можна за допомогою кнопки Eraser .  

Проекційні формули Фішера зображаються за допомогою кнопок групи 

Bonds     . Щоб дзеркально відобразити структуру, варто її 

скопіювати і вставити заново та, не знімаючи виділення, обрати меню 

Object → Flip Vertical, потім Object → Rotate 180° Horizontal та Object → Rotate 

180° Vertical.  

Зміна геометрії структури відбувається при виділенні та перетягуванні 

частин молекули, які потрібно змінити. Для зміни розміру структури варто 

виділити її повністю і потягнути за вузли рамки. 

1.3.3. Експериментальна частина 

Мета роботи: освоєння методики побудови двовимірних моделей 

молекулярних структур. 

Завдання для лабораторної роботи: 

1. Побудувати молекулярну структуру заданого об’єкта (за вибором 

викладача) у програмному пакеті ChemDraw. Зробити кілька копій структури 

(4–5) для подальших дій. 

2. Згенерувати назву побудованої структури за номенклатурою IUPAC. 

3. Визначити молекулярну масу зображеної частинки. Записати її під 

структурою у вигляді текстового блока. 

4. Застосувати форматування: шрифт Times New Roman, розмір 14, колір 

позначення елементів: С – чорний, О – червоний, Н – сірий, N – синій, Cl – 

зелений, інші елементи – чорний.  
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5. Перетворити модель нейтральної молекули на модель зарядженої 

частинки (катіону або аніону).  

6. Перетворити одинарні зв’язки у структурі на кратні (подвійні, 

потрійні). 

7. Надати об’єм двомірній структурі, зобразивши її у вигляді 

проекційної формули Фішера. Скопіювати й відобразити отриману проекцію 

(перетворити її на її енантіомер). 

8. Змінити довжини зв’язків, валентні кути, загальний розмір структури, 

обернути її на заданий кут. 

9. У звіт про роботу внести усі отримані у процесі роботи структури. 

Зробити висновок про можливості програмного пакета ChemDraw. 

1.3.4. Питання для самоконтролю 

1. Чи відображає візуалізована молекулярна структура істинне взаємне 

розташування атомів у молекулі? 

2. Складіть алгоритм побудови структури 4-ацетамідобензойної кислоти 

у програмі ChemDraw. 

3. Опишіть дії, за допомогою яких можна отримати назву сполуки за її 

візуалізованою структурою та навпаки – отримати структуру з назви. 

4. З якою точністю визначається молекулярна маса сполуки засобами 

програми ChemDraw? 

5. Що таке енантіомери? 

6. Що таке валентний кут? 
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1.4. Оптимізація молекулярних структур  

 

1.4.1. Теоретична частина 

Оптимізація молекулярної геометрії дає змогу дослідити структуру 

молекули та її енергію вільному стані (у вакуумі або розрідженому газі). На 

сьогодні оптимізація молекулярної геометрії є основним типом 

комп’ютерного експерименту. Він полягає у багатократному обчисленні 

хвильової функції та енергії молекули і варіації структурних параметрів так, 

щоб досягти структури, що відповідає мінімуму повної енергії молекули. 

Варіація, здебільшого, включає в себе початковий розрахунок енергії при 

вихідній (заданій користувачем) структурі, оцінку градієнта енергії у цій точці 

поверхні потенціальної енергії (ППЕ) (іноді також точну або наближену 

оцінку гессіану), вибір нових структурних параметрів (нової точки ППЕ) на 

основі інформації про градієнт та / або гессіан, і перевірку виконання умов 

припинення процесу оптимізації (критеріїв збіжності). Такими умовами є:  

 малість норми градієнта або середнього квадрата компоненти градієнта; 

 малість максимальної компоненти градієнта; 

 малість довжини кроку або його максимальної компоненти; 

 малість зміни енергії на кількох послідовних кроках. 

У більшості програм передбачено також зупинку при перевищенні числа 

кроків (циклів) оптимізації або часу роботи. 

  Побудова вихідної структури здійснюється у програмі-візуалізаторі, 

наприклад, Chemcraft. Вигляд робочого вікна Chemcraft наведений на 

рис. 1.4.1. Програма дає змогу будувати структури хімічних сполук і 

молекулярних ансамблів на основі вбудованого набору молекулярних 

фрагментів, а також індивідуальних атомів.  
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Рис. 1.4.1. Вигляд робочого вікна програми Chemcraft 1.8 

 

Для зручної побудови та візуального представлення молекулярної 

структури використовують кнопки на панелях інструментів вкладки Image: 

 Copy image  – зберігання структури як зображення у буфер обміну 

(скріншот);  

 Кнопка Drag atoms  і група кнопок , що активуються при її 

натисканні – перетягування індивідуальних атомів, молекулярних фрагментів 

і молекул, відповідно;  

 Center  – центрування структури у робочому вікні програми; гаряча 

клавіша – Space; 

 Best view  – відображення структури так, щоб усі її атоми було видно 

якомога краще; гаряча клавіша – Enter; 

 Update the center of mouse rotation  – оновлення автоматичного 

центрування структури при обертанні мишкою; 

 Група кнопок Atom labels  – вмикання відображення 

символів елементів на атомах, номерів атомів, символів та номерів разом, 
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налаштування стилю відображення підписів на атомах та очистка підписів, 

відповідно; 

 Show axes  – відображення осей декартових координат на структурі; 

 Isometry  – режим зберігання розмірів атомів при зміні положення 

структури у просторі; 

 Perspective  – режим пропорційного відображення розмірів атомів у 

перспективі; 

 Magnifier  – “збільшувальне скло”, область на екрані, що відображає 

збільшені фрагменти структури при наведенні; 

 Група кнопок Multiple selection  – виділення кількох атомів та 

автоматичне включення сусідніх атомів та груп атомів у виділення, 

відповідно; 

 Група кнопок Rotation  – обертання молекулярної 

структури за трьома осями координат, відповідно; 

 Група кнопок Move forward / backward  – пересування 

молекулярної структури вперед і назад, відповідно; 

 Група кнопок Zoom in / out  – приближення і віддалення 

молекулярної структури, відповідно; 

 Група кнопок Move  – зміщення молекулярної структури у 

відповідних напрямках стосовно робочого вікна програми. 

1.4.2. Методичні вказівки 

Щоб отримати структуру молекули у програмному пакеті ChemCraft, 

необхідно “зібрати” її з фрагментів (меню View → Add fragment або 

комбінація клавіш Ctrl+F) та окремих атомів (меню View → Add atom або 

комбінація клавіш Ctrl+A). Варто взаємно розташовувати атоми та групи 

атомів, керуючись знаннями про валентності, гібридизації, валентні кути та 

електростатичну взаємодію атомів. Стилі відображення молекулярної 

структури знаходяться у меню Display. 
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При виділенні одного і більше атомів у рядку стану внизу вікна 

програми ChemCraft з’являється додаткова інформація. Якщо виділення 

відсутнє, зліва у рядку стану є надпис “Nothing selected.” (“Нічого не 

вибрано.”). Виділення одного атому приводить до появи його декартових 

координат справа у рядку стану у вигляді трьох чисел. Два виділені атоми 

дають значення міжатомної відстані (довжини зв’язку) між ними в Å 

(ангстрем, 1·10–10
 м); три атоми – валентного кута між відповідними хімічними 

зв’язками, °; чотири атоми – торсійного (двогранного) кута між двома 

площинами, у яких лежать виділені хімічні зв’язки, °. Довжини зв’язків і 

величини кутів можуть бути відображені безпосередньо на структурі при 

натисненні кнопки  поруч зі значенням величини. Також значення 

координат, довжин валентних зв’язків, величин валентних і торсійних кутів 

можна задавати власноруч. Поле із відповідною величиною стає здатним до 

редагування при натисканні на ньому. Після введення потрібного значення 

варто натиснути кнопку  поруч із полем або клавішу Enter на клавіатурі. 

Можливі два випадки: якщо активною є кнопка , структура змінюється 

симетрично в усіх напрямках (за усіма виділеними атомами); якщо активна 

кнопка , змінюється положення (координати) тільки останнього 

виділеного атома, а усі інші атоми залишаються із фіксованими координатами. 

Декартові координати побудованої структури знаходяться на вкладці 

Coord. Для застосування їх у програмі Firefly 8.2.0 необхідно натиснути на 

кнопку Show in format у нижній частині вікна й обрати GAMESS-US input, а 

потім скопіювати кнопкою Copy. 

Файл вихідних даних для оптимізації молекулярної структури (“opt”, без 

розширення або із розширенням .inp) містить кілька програмованих блоків, які 

починаються з пробілу, символу “$” та назви блока, що закінчуються 

пробілом, символом “$” і словом “END”. Скопійовані координати структури 

мають вигляд блоку $DATA, його необхідно вставити у текст файлу “opt” 

замість наявного блоку $DATA. 
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Перш ніж приступати до роботи, варто налаштувати програму Firefly 

8.2.0 (рис. 1.4.2). Налаштування проводиться одноразово, повторювати його 

при наступних запусках програми не потрібно. 

 

Рис. 1.4.2. Вигляд робочого вікна й діалогового вікна налаштувань програми 

Firefly 8.2.0 через графічний інтерфейс FiCo (Firefly Commander) 

 

Програма запускається через додаток FiCo.exe. Налаштування 

виконується натисканням кнопки Settings. Основні налаштування знаходяться 

на вкладці Firefly: 

 у рядку Firefly executable варто вказати шлях до додатку Firefly.exe у 

папці з програмою; 

 рядок External basis set library file залишити порожнім; 
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 у блоці Working directories вибрати чекбокс Auto-create і вказати шлях 

до папки з програмою Firefly 8.2.0; 

 поставити усі три галочки в чекбоксах Remove temporary scratch files, 

Forces execution with old PUNCH or IRCDATA files, Redirects all text to output 

file directory; 

 рядок Additional command line options залишити порожнім; 

 в пункті CPU cores вказати кількість ядер процесора, які будуть задіяні 

для розрахунку (залежить від комп’ютера, оптимально – половина наявних 

фізичних ядер); 

 у пункті Output file вибрати формат імені кінцевих output-файлів: .out – 

автоназва, яка відповідає назві вихідного input-файлу (наприклад, з файлу opt 

утвориться файл opt.out) (рекомендується для виконання цієї роботи), _N.out 

– автоназва, яка відповідає назві вихідного input-файлу, з послідовною 

нумерацією (наприклад, opt → opt_1.out, opt_2.out при повторному запуску), 

? – назва output-файлу кожен раз задається вручну. 

Вкладку Other залишити без змін. Для запуску оптимізації геометрії 

варто перемістити input-файл “opt” у вікно програми Firefly 8.2.0 і натиснути 

кнопку Run, потім дочекатися закінчення розрахунку (процес розрахунку 

відображається в нижньому блоці вікна програми).  

По закінченні розрахунку унизу вікна програми перестають з’являтися 

нові рядки, останнім є рядок “EXECUTION OF FIREFLY TERMINATED 

NORMALLY” (“Виконання Firefly завершено нормально”).  

Файл із результатами розрахунку “opt.out” можна відкрити за 

допомогою програми ChemCraft. Якщо геометрія оптимізована, у лівій частині 

вікна з’явиться рядок “Optimized geometry”. Щоб визначити атомні 

характеристики, необхідно натиснути на цей рядок, виділити потрібний 

фрагмент структури і поставити внизу зліва галочку “Show atomic properties”. 

Далі варто обрати з випадаючого списку потрібні параметри – заселеність 

(Mull. pop.) і заряд атома (Mull. charge) за Маллікеном, загальну валентність 
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(Total valence). Порядок зв’язку є параметром зв’язку, а не атома, тому для 

його відображення варто виділити потрібний зв’язок і поставити галочку Show 

bond properties, у списку обрати порядки зв’язку (Bond orders). 

Для знаходження кількості та енергії молекулярних орбіталей варто при 

виділеному рядку “Optimized geometry” натиснути кнопку Tools зліва внизу 

робочого вікна ChemCraft і в меню, що з’явилось, обрати Show MO energies 

diagram. Програма відобразить діаграму молекулярних орбіталей (МО) 

речовини зі значеннями енергії, які варто перевести у еВ (у випадаючому 

списку зверху справа треба обрати MO energies (eV)). Позначення Occupied 

відповідає зайнятим МО, тоді як Unoccupied – вакантним МО. 

1.4.3. Експериментальна частина 

Мета роботи: освоєння методики побудови тривимірних моделей 

молекулярних структур та оптимізації їх геометричних параметрів 

квантовохімічними методами. 

Завдання для лабораторної роботи: 

1. Побудувати молекулярну структуру заданого об’єкта (за вибором 

викладача) у програмному пакеті ChemCraft. 

2. Почергово застосувати різні (5–6) стилі відображення молекулярної 

структури. Залишити будь-який зручний стиль, відмінний від стандартного. 

3. Задати вихідні координати об’єкта в input-файлі програми Firefly 8.2.0 

та оптимізувати його геометрію. 

4. Відкрити візуалізацію оптимізованої геометрії в ChemCraft. Для 

вибраної групи з 4 атомів (за вибором викладача) визначити довжину зв’язків, 

валентні кути, торсійний кут, заселеність і заряд за Маллікеном, загальну 

валентність, порядки зв’язків. Занести дані у табл. 1.4.1. 

5. Виписати у табл. 1.4.2 енергії зайнятих і вакантних молекулярних 

орбіталей оптимізованої структури. 
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Таблиця 1.4.1. Геометричні параметри фрагмента оптимізованої структури 

Оптимізована структура 

 
 
 
 
 

Фрагмент структури для аналізу  

Довжина зв’язку l, нм 
   
   

Валентний кут, ° 
  
  

Торсійний кут, °  

Заселеність атома за Маллікеном     
    

Заряд атома за Маллікеном 
    
    

Загальна валентність атома 
    
    

Порядок зв’язку n    
   

 

Таблиця 1.4.2. Енергія молекулярних орбіталей оптимізованої структури 

Зайняті орбіталі Вакантні орбіталі 
№ Е, еВ № Е, еВ 
1  n + 1  
2  n + 2  
3  n + 3  
…  …  
n  n + m  

 

6. Зробити висновки про інформацію, яку можна отримати при оптимізації 

молекулярної геометрії сполук. 

1.4.4. Питання для самоконтролю 

1. У чому полягає оптимізація молекулярної геометрії? 

2. Наведіть умови припинення процесу оптимізації. 

3. Дайте визначення довжини зв’язку, валентного кута, торсійного кута. 

4. Що таке заселеність і заряд атома за Маллікеном?  
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1.5. Квантовохімічне моделювання бімолекулярної хімічної реакції 

 

1.5.1. Теоретична частина 

У квантовій хімії кожну стадію реакції прийнято розглядати як 

елементарний акт (одиничний акт перетворення реактантів на продукти). 

Профіль ППЕ уздовж координати реакції для елементарного акту (загалом) 

містить 5 особливих точок (рис. 1.5.1): 

1. Нескінченно віддалені реактанти. 

2. Передреакційний комплекс – ван-дер-ваальсовий або зі специфічними 

взаємодіями. 

3. Перехідний стан. 

4. Післяреакційний комплекс – ван-дер-ваальсовий або зі специфічними 

взаємодіями. 

5. Нескінченно віддалені продукти. 

 

 

Рис. 1.5.1. Енергетичний профіль ППЕ уздовж координати реакції для 

елементарного акту деякого багатостадійного процесу 
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Розрахунок ППЕ хімічної реакції полягає в оптимізації геометрії та 

енергії реакційної системи при фіксованих координатах атомів. Координата 

реакції проходить через енергетичну улоговину ППЕ. Вона поєднує через 

одномірний максимум два локальні мінімуми, що відповідають реактантам і 

продуктам реакції. Одномірному максимуму відповідає перехідний стан. У 

цих точках виконуються умови стаціонарності (рис. 1.5.2): похідна від 

потенціальної енергії за усіма координатами (градієнт енергії) дорівнює нулю: 

∂U/∂Qi = 0, i = 1, 2,…, 3N – 6(5) (1.5.1)

У мінімумі усі власні значення матриці G других похідних від 

потенціальної енергії за координатами (матриці Гессе або гессіана) позитивні: 

Gii = ∂2U/∂Qi
2 > 0, i = 1, 2,…, 3N – 6(5) (1.5.2)

Qi – нормальні коливальні координати. 

 

 

Рис. 1.5.2. Стаціонарні точки ППЕ: локальний мінімум (а), одномірний 

максимум – сідлова точка (б), двомірний максимум (в) 

 

У сідловій точці перехідного стану (одномірному локальному 

максимумі) на ППЕ, для набору нормальних координат Qi, у базисі яких 

матриця Гессе діагональна (∂2U/∂Qi∂Qj = 0, i ≠ j) із власних чисел гессіану одне 

і тільки одне негативне: 

∂2U/∂Qr
2 < 0, для деякої координати Qr 

∂2U/∂Qi
2 > 0, при i ≠ r 

(1.5.3)
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Координата реакції Qr – єдина (згідно з доказом Маррела і Лейдлера) 

нормальна координата у профілі ППЕ, уздовж якої перехідний стан є 

максимумом. У профілях ППЕ уздовж інших координат перехідний стан – 

мінімум. Тому перехідний стан також називається сідловою точкою на ППЕ. 

Матриця Гессе є матрицею силових констант. Її власні вектори Qi – 

нормальні координати, а власні числа – енергії коливань реакційної системи 

(у гармонічному наближенні) при значенні повного коливального квантового 

числа, що дорівнює нулю. Виконання умови (1.5.3) означає, що одна (і тільки 

одна) з частот коливань перехідного стану має бути уявною (негативною). 

Найефективнішими методами пошуку стаціонарних точок є градієнтні 

методи, зокрема, методи найшвидшого спуску, як-от метод Ньютона-Рафсона. 

Сутність пошуку зводиться до того, що задається початкове наближення до 

геометрії молекули, яка потім оптимізується ітераційним шляхом. У сучасних 

квантовохімічних програмних комплексах задача, здебільшого, розв’язується 

у декартових координатах. На кожній ітерації кожна i-та варійована 

координата атома (α, β = x, y, z) змінюється на величину, що називається 

кроком. Крок прямо пропорційний до першої похідної ∂U/∂αi (градієнта 

енергії) і обернено пропорційний до суми по j елементів гессіана Σ∂2U/∂αi∂βj. 

Напрямок найшвидшого спуску визначається градієнтом енергії зі зворотним 

знаком. 

Обчислення завершуються, коли сума абсолютних величин усіх перших 

похідних ∂U/∂αi стає менше за певне мале значення ε. В сучасних 

квантовохімічних програмних комплексах звичайно використовують значення 

ε ≈ 10–5. Крім того, контролюється виконання теореми виріалу. Реальний час 

розрахунку стаціонарних точок ППЕ визначається якістю геометрії нульового 

наближення. Істотну складність створює багатовимірність простору 

оптимізованих параметрів і, особливо, та обставина, що значення похідних 

∂U/∂αi можуть істотно відрізнятись для різних αi. Цим фактом іноді 

обумовлена слабка збіжність процесу. 
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Спроби розробити загальний алгоритм локалізації перехідного стану 

привели до інтуїтивних неоднозначних уявлень про шлях хімічної реакції, що 

з’єднує сусідні мінімуми ППЕ через сідлову точку перехідного стану. 

Очевидно, що таких шляхів можна побудувати багато. За класичним 

визначенням Ейринга і Поляні (1931 р.) шлях хімічної реакції – це шлях 

мінімальної енергії. 

У 1970 р. Фукуї дав визначення єдиної внутрішньої координати 

реакції – шляху найшвидшого спуску з перехідного стану у долину реактантів 

або продуктів, що задовольняє класичним рівнянням руху: 

Qi = ∂H/∂pi, pi = – ∂H/∂Qi (1.5.4)

Тут Qi – компонента похідної внутрішньої координати реакції за часом, 

pi – компонента похідної узагальненого (спряженого) імпульсу за часом, H – 

функція Гамільтона молекули. 

 Сьогодні шлях хімічної реакції звичайно визначають як шлях, що 

задається внутрішньою координатою реакції у базисі мас-зважених координат. 

Мас-зважені координати визначаються як Qi = Σi mi
1/2аiαi , де αi = x, y, z; аi – 

коефіцієнти розкладу внутрішньої координати реакції за декартовими. 

Внутрішня координата реакції Q – це шлях мінімальної енергії, що проходить 

через долину реактантів, долину продуктів і точку перехідного стану. 

Якщо перехідний стан відомий, то шлях хімічної реакції може бути 

відновлений за методом локальної квадратичної апроксимації. Внутрішня 

координата реакції задається власним вектором матриці Гессе, що відповідає 

одному негативному власному значенню (див. умову (1.5.3)), навколо 

перехідного стану, і шляхами найшвидшого спуску у долину реактантів і в 

долину продуктів поза перехідним станом. Таку можливість надає, наприклад, 

програмний комплекс Firefly. 

Якщо перехідний стан невідомий, то визначення внутрішньої 

координати реакції можливе за найпростішим варіантом методу координати 

реакції: виокремлюють один структурний параметр реакції та монотонно його 
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варіюють, оптимізуючи на кожному кроці інші ступені свободи системи. 

Однак виявилось, що цей метод працює лише у разі мономолекулярних 

реакцій дисоціації або утворення окремого локалізованого зв’язку та у разі 

бімолекулярних SN2-реакцій, у яких розрив та утворення зв’язку відбувається 

синхронно. В інших випадках координата реакції є лінійною комбінацією 

структурних параметрів реакційної системи. 

Перехідний стан може бути локалізований за методом слідування 

вздовж власного вектора матриці Гессе у напрямку з найменшою (ймовірно, 

негативною) кривизною, що реалізується, наприклад, у програмному 

комплексі Firefly. Іноді метод дає змогу розрахувати перехідний стан навіть 

тоді, коли у нульовому наближенні усі власні значення гессіану позитивні. 

Адекватне наближення для початкової геометрії рівноважних станів 

молекул і молекулярних комплексів, що беруть участь у реакції, дають 

рентгено- та електроноструктурний аналіз або спектроскопічні структурні 

дослідження. Геометрію перехідного стану, ймовірно, можна буде отримати 

методом імпульсного структурного аналізу, що використовує синхротрони та 

координаторні детектори. 

Якщо форма ППЕ близька до параболічної, істотну допомогу для 

визначення геометрії перехідного стану може надати постулат Хеммонда, що 

пов’язує геометрію перехідного стану з тепловим ефектом реакції. За 

Хеммондом, екзотермічним реакціям відповідає реактантоподібний 

перехідний стан, ендотермічним – продуктоподібний, теплонейтральним – 

той, що займає проміжне положення між реактантами та продуктами. 

1.5.2. Методичні вказівки 

Для моделювання реакції необхідно побудувати молекулярні структури 

реактантів у програмному пакеті ChemCraft, взаємно розташовуючи їх 

найзручнішим для взаємодії способом, з огляду на ймовірний механізм 

досліджуваної реакції. 
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Координати отриманої системи у форматі GAMESS-US input (див. 

лабораторну роботу 1.4, пункт 1.4.2) потрібно скопіювати і вставити у файл 

“saddlepoint” замість наявного блоку $DATA. Потім варто провести 

розрахунок (див. методичні вказівки до лабораторної роботи 1.4) сідлової 

точки реакції (input-файл “saddlepoint”) у програмі Firefly 8.2.0. Результат 

розрахунку – файл “saddlepoint.out” – потрібно відкрити за допомогою 

програми ChemCraft.  

Координати оптимізованої геометрії реакційної системи далі копіюють 

в input-файл “hessian” (замість блоку $DATA). Потім запускають розрахунок 

функції гессіану для досліджуваної реакції. 

Важливо! У файлі “hessian.out” приведені значення частот ІЧ-спектру, 

причому одна і тільки одна з них мусить мати негативне значення 

(уявна частота).  

Координати перехідного стану копіюють в input-файл “IRC_false”. При 

розрахунку гессіану також створюється допоміжний файл “PUNCH”. Його 

потрібно відкрити за допомогою програми Блокнот, знайти блок $HESS і 

скопіювати його значення в input-файл “IRC_false” замість наявного блоку 

$HESS. Далі створити копію файлу “IRC_false”, перейменувати його в 

“IRC_true”, відкрити Блокнотом, знайти блок $IRC і змінити значення у рядку 

FORWRD на FORWRD=.true. для розрахунку другої гілки координати реакції. 

Запустити розрахунок за процедурою IRC. 

Скопіювати координати геометрії продуктів і реактантів із файлів 

“IRC_true.out” і “IRC_false.out” у відповідні input-файли “opt_IRC_true” і 

“opt_IRC_false”. Провести оптимізацію геометрії продуктів і реактантів. 

Скопіювати координати оптимізованої геометрії продуктів і реактантів 

із файлів “opt_IRC_true.out” і “opt_IRC_false.out” у відповідні input-файли 

“hessian_IRC_true” і “hessian_IRC_false”. Провести розрахунок функції 

гессіану для продуктів і реактантів. Загальна схема розрахунку шляху реакції 

показана на рис. 1.5.3.  
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Рис. 1.5.3. Схема квантовохімічного моделювання реакції у програмі 

Firefly 8.2.0 

 

Енергетичні характеристики різних станів реакції можна отримати з 

відповідних output-файлів для розрахунку гессіану реактантів, ПС і продуктів. 

Для цього треба відкрити output-файл гессіану відповідної системи у програмі 

ChemCraft і перейти на вкладку Source. Варто пролистати вкладку Source 

донизу і знайти блоки енергетичних параметрів (E, H, G, CV, CP, S) у кДж/моль 

(kJ/mol). Для подальшого розрахунку необхідні тільки загальні величини 

енергії (total).  

Активаційні параметри реакції розраховують як різницю між 

відповідними величинами для перехідного (ПС) та вихідного (ВС) стану 

системи: 

Eа = Etot (ПС) – Etot (ВС) 

∆H≠ = ∆H (ПС) – ∆H (ВС) 

∆G≠ = ∆G (ПС) – ∆G (ВС) 

∆S≠ = ∆S (ПС) – ∆S (ВС) 
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Константу рівноваги отримують на основі таких розрахунків, де 

ПР – продукти реакції: 

∆Hр = ∆H (ПР) – ∆H (ВС) 

∆Sр = ∆S (ПР) – ∆S (ВС) 

ΔGр = ΔH – TΔS  

Kp = e–∆G/RT 

 

1.5.3. Експериментальна частина 

Мета роботи: освоєння методики моделювання хімічних реакцій 

квантовохімічними методами шляхом знаходження конфігурації перехідного 

стану і виконання процедури спуску в долину реактантів і продуктів реакції. 

Завдання для лабораторної роботи: 

1. Побудувати молекулярні структури заданих реактантів (за вибором 

викладача) у програмному пакеті ChemCraft. 

2. Отримати оптимізовану геометрію сідлової точки. 

3. Розрахувати гессіан перехідного стану. Значення уявної частоти –iν і 

геометричних параметрів ПС занести у табл. 1.5.1. 

4. Провести розрахунок шляху реакції за процедурою IRC у долини 

реактантів і продуктів. 

5. Отримати оптимізовану геометрію продуктів та реактантів. 

 

Таблиця 1.5.1. Геометричні параметри перехідного стану 

 
 

ПС 
 
 
 

 
 

-iν, 
см–1 

l, Å Валентний кут, º
Торсійний  
кут, º n 
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6. Розрахувати гессіан продуктів і реактантів.  

7. Отримати із відповідних output-файлів для розрахунку гессіану 

енергетичні характеристики реактантів, ПС і продуктів та занести їх у 

табл. 1.5.2. Обчислити енергетичні ефекти реакції і додати їх у табл. 1.5.2. 

8. Розрахувати активаційні параметри реакції та константу рівноваги і 

занести у табл. 1.5.3. 

 

Таблиця 1.5.2. Енергія основних станів реакції 

Система ZPE, 
кДж/моль 

Etot, 
кДж/моль 

∆H, 
кДж/моль 

∆G, 
кДж/моль 

∆S, 
Дж·моль/K 

Реактанти      
ПС      
Продукти      
Реакція      

 

Таблиця 1.5.3. Активаційні параметри реакційної системи 

Kр (298 K) Eа, кДж/моль ∆H≠, кДж/моль ∆G≠, кДж/моль ∆S≠, Дж·моль/K 
     

 

9. У висновках охарактеризувати досліджувану реакцію з погляду 

термодинамічних властивостей. 

1.5.4. Питання для самоконтролю 

1. Зобразіть енергетичний профіль ППЕ елементарної реакції, позначте 

особливі точки на ньому. 

2. Що таке сідлова точка? 

3. Що таке внутрішня координата реакції? 

4. Сформулюйте постулат Хеммонда. 

5. Наведіть алгоритм (схему) квантовохімічного моделювання реакції у 

програмі Firefly 8.2.0. 

6. Наведіть формули для розрахунку активаційних параметрів та 

константи рівноваги.  
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1.6. Моделювання кінетики хімічної реакції 

 

1.6.1. Теоретична частина 

Хімічна кінетика – наука про закономірності перебігу хімічних реакцій 

у часі, а також механізми хімічних реакцій. Основними задачами хімічної 

кінетики є:  

 розрахунок швидкості реакції та побудова кінетичних кривих, тобто 

залежностей концентрації реагуючих речовин і продуктів від часу 

(пряма задача); 

 визначення кінетичного закону та механізму реакції за зміною 

концентрації реагуючих речовин і продуктів у часі (зворотна задача). 

Програма KINET призначена для розв’язання прямих і зворотних 

кінетичних задач (рис. 1.6.1). Як вихідні дані задають кінетичну схему 

(механізм) процесу у вигляді набору простих реакцій із зазначенням констант 

швидкості, причому рівняння реакцій можуть бути записані у формі, близькій 

до звичайних хімічних позначень.  

 

 

Рис. 1.6.1. Вигляд робочого вікна програми Kinet 
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Крім того, вказують умови процесу – початкові концентрації реагентів і 

температуру, а також часовий інтервал, на якому потрібно отримати розв’язок. 

У разі зворотної кінетичної задачі необхідно додатково задати 

експериментальні кінетичні криві. 

Програма самостійно складає систему диференціальних рівнянь та 

інтегрує її. Результати представляються у чисельному та графічному вигляді і 

можуть бути експортовані для використання в інших програмах. 

1.6.2. Методичні вказівки 

Введення даних у програму Kinet починається із вкладки “Механизм”. 

Тут має бути заданий набір простих реакцій, що описує процес, з константами 

швидкості. Реакції можуть бути описані як схематично (рис. 1.6.1), так і 

подібно до звичного запису хімічних реакцій. Програма є чутливою до 

регістру, тобто а та А можуть бути позначеннями для двох різних речовин. 

Ліву і праву частину рівняння розділяє знак “=” або “=>”, окрім реакції 

нульового порядку, у якій варто застосовувати комбінацію символів “=0>”.  

Для розв’язку зворотної задачі необхідно задати наближені 

(передбачувані) константи швидкості, наприклад, 0,001. При заданні значень 

констант швидкості реакції стовпці “Еа” та “n” варто залишити порожніми. 

Для уточнення значення константи швидкості варто встановити галочку в 

чекбоксі зліва від стовпця “k(298.15)”. 

За заданим набором реакцій програма складає систему диференціальних 

рівнянь, що є математичною моделлю цього процесу. Щоб побачити ці 

рівняння, необхідно перейти на вкладку “Модель”. На цій вкладці задаються 

початкові концентрації усіх учасників реакції.  

Експериментальні криві задаються на вкладці “Експеримент”. Введення 

даних можливий після того, як визначена модель (складений список речовин). 

Експериментальні кінетичні криві необхідні для розв’язання зворотної 

кінетичної задачі. Крім того, експериментальні криві можна використовувати 

для порівняння з результатами розрахунку при розв’язку прямої задачі. У 



Комп’ютерне моделювання хімічних процесів 
 

39 
 

стовбець “Время” вводять експериментальні точки часу, при якому визначали 

концентрацію речовини. Додати стовпці для концентрації можна, обираючи 

позначення необхідної речовини з випадаючого списку над таблицею і 

натискаючи кнопку “Добавить”. Можна додати концентрації усіх учасників 

хімічної реакції – як реагентів, так і продуктів. 

Розрахунок зворотної задачі виконується за допомогою меню “Расчет”. 

У підменю “Режим” варто задати температуру реакції (за 

замовчанням – 298,15 K), обрати у меню “Расчет” режим “Обратная задача” і 

натиснути “Старт” або F5. При цьому з’являється вкладка “Обратная задача” 

з результатами розрахунку. Натиснення кнопки “Принять” замінює наближену 

константу (або константи) швидкості реакції на вкладці “Механизм” на 

оптимізовану константу, отриману внаслідок розв’язку зворотної задачі. 

Значення оптимізованої константи використовується для розв’язку прямої 

кінетичної задачі. 

Після прийняття уточненого значення константи варто зняти галочку в 

чекбоксі на вкладці “Механизм” і, не змінюючи модель та експериментальні 

дані, переключити режим розрахунку на пряму задачу (Расчет → Прямая 

задача). Необхідно також задати режим розрахунку (Расчет → Режим): зняти 

галочку “Автовыбор шага” і задати крок і межу часу згідно з 

експериментальними даними. Доцільно обирати максимальний час, що 

приблизно відповідає проходженню реакції на 100 %, або у разі обернених 

процесів – максимально можливому ступеню конверсії. Чим меншим є крок, 

тим точніше будується розрахункова кінетична крива (рекомендується крок = 1). 

Після задання параметрів розрахунку варто натиснути “Старт” або F5. При 

цьому з’являються вкладки “Решение” і “График 1”, що містять розрахункові 

значення часу й концентрації речовин у кожній точці графіку та самі кінетичні 

криві, відповідно. 

Редагування параметрів відображення розрахункових графічних 

залежностей можна за правим кліком мишею на графіку → Формат графика. 
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У цьому меню можна вмикати і вимикати відображення розрахункових 

кривих, змінювати колір, товщину та стиль ліній, налаштовувати віднесення 

вісей, зображення ліній, сітки і фону, а також змінювати масштаб графіка. 

Для перегляду координат точки на кінетичній кривій варто зробити клік 

лівою кнопкою миші по цій точці. Координати будуть відображені поряд із 

точкою із вказанням осей, до яких вони належать. 

1.6.3. Експериментальна частина 

Мета роботи: освоєння методики розв’язання прямої та зворотної задач 

хімічної кінетики методом моделювання. 

Завдання для лабораторної роботи: 

1. На основі експерименту (отримати у викладача) внести у програму 

“Kinet” дані про механізм реакції, зміну концентрації реагентів (C) у часі (t), а 

також наближене значення константи швидкості реакції (k). 

2. Визначити точне значення константи швидкості реакції в режимі 

“Обратная задача”. 

3. Прийняти розраховане значення константи швидкості. Занести 

отриману величину в табл. 1.6.1. У режимі “Прямая задача” побудувати 

кінетичну криву для досліджуваної реакції. У разі, якщо експериментальні 

точки не узгоджуються із розрахунковими кінетичними кривими, тобто 

випадають з графіка, змінити запис механізму реакції у програмі “Kinet” 

відповідно до ймовірного порядку реакції та повторити розрахунок зворотної 

задачі. 

4. Форматувати отриманий графік: колір кривої витрачання вихідного 

реагенту – червоний, товщина ліній – 1; колір кривої накопичення 

продукту – синій, товщина ліній – 2. У разі, коли кількість реагентів і / або 

продуктів відрізняється від 1, варто застосувати для них такі ж налаштування 

форматування, але обрати інший стиль (наприклад, штрих-пунктирна лінія). 
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5. За допомогою отриманого графіка розрахувати, через який час реакція 

пройде на різну глибину конверсії (α) (табл. 1.6.1). Занести значення часу в 

табл. 1.6.1. 

 

Таблиця 1.6.1. Кінетичні закономірності досліджуваної реакції 

α, % C, моль/л t, с k n 
10   

 

 
25   
50   

Розмірність  75   
100   

 

6. У висновках вказати можливі способи застосування моделювання 

кінетики хімічних реакцій. 

1.6.4. Питання для самоконтролю 

1. Що таке механізм реакції? 

2. Яка комбінація символів має розділяти ліву та праву частини 

хімічного рівняння при записі механізму реакції нульового порядку у програмі 

Kinet? 

3. У чому полягають пряма та зворотна кінетичні задачі? 

4. Що таке ступінь конверсії? 

5. Яку розмірність мають константи швидкості реакцій нульового, 

першого, другого порядків? 

6. Наведіть алгоритм визначення часу реакції при різних ступенях 

конверсії за кінетичною кривою у програмі Kinet. 
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2. ОБ’ЄКТИ ДЛЯ МОДЕЛЮВАННЯ 

 

2.1. Побудова моделі лінійної однопараметрової кореляції 

 

1) Залежність тиску 
насиченої пари 
етилацетату від 
температури  

2) Екстракція оцтової 
кислоти 

3) Екстракція йоду 

1/T ln p lg c1 lg c2 lg c1 lg c2 
0,003425 4,382  –1,602 0,8673  –3,921  –2,260 
0,003289 4,868  –1,677 0,8421  –3,889  –2,237 
0,003145 5,416  –1,734 0,8193  –3,854  –2,181 
0,003067 5,720  –1,824 0,7764  –3,800  –2,020 
0,003012 5,940  –1,898 0,7457  –3,772  –1,998 
0,002959 6,174  –1,965 0,7024  –3,770  –1,978 
0,002907 6,397  –2,048 0,6744  –3,745  –1,928 
0,002882 6,515  –2,123 0,6298  –3,620  –1,747 
0,002865 6,579  –2,255 0,5741  –3,604  –1,724 

4) Йодування ацетону 5) Мутаротація глюкози
6) Кислотне омилення 

етилацетату 

t, c V, мл t, с 
ln 

(t – ∞) 
t, с 

(V∞ – Vt)–1,  
мл–1 

300 12,0 300 3,332 600 2,370 
600 11,4 600 3,243 1200 2,251 
900 11,1 900 3,163 1800 2,079 

1200 10,6 1200 3,068 2400 1,946 
1500 10,3 1500 2,983 3000 1,792 
1800 10,0 1800 2,904 3600 1,740 
7) Розкладання 

сечовини у водному 
розчині 

8) Розкладання манган 
триоксалату 

9) Лужне омилення 
етилацетату 

t, с ln ( ∞ − ) t, с ln Dt t, с Rt, Ом 
600  –3,243 60  –1,022 120 530,8 
900  –3,245 120  –1,050 180 536,9 

1200  –3,246 180  –1,079 240 543,5 
1500  –3,248 240  –1,139 300 546,8 
1800  –3,250 300  –1,171 360 552,9 
2100  –3,252 360  –1,238 420 558,5 
2400  –3,253 420  –1,273 480 563,0 
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10) Гідроліз 
кристалічного 
фіолетового 

11) Розкриття ЕХГ 
бензойною кислотою 

12) Розкриття ЕХГ 
оцтовою кислотою 

t, с ln Dt t, с CБК, М t, с CОК, М 
0  –1,39 0 0,303 0 0,201 

120  –1,42 7200 0,245 3600 0,192 
240  –1,45 9000 0,226 7200 0,188 
360  –1,49 10800 0,211 10800 0,173 
480  –1,52 14400 0,173 14400 0,163 
600  –1,55 18000 0,139 18000 0,153 
720  –1,58 21600 0,107 21600 0,145 
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2.2. Побудова моделі множинної регресії 

 

1) 2) 3) 
Y X1 X2 X3 Y X1 X2 X3 X4 Y X1 X2 X3 

0,9 100 18,9 43 10,3 15,8 0 249,64 0 –3,71 –0,15 –0,79 4,9 
1,7 140 13,7 64,7 11,2 16,4 25 268,96 625 –2,99 –0,3 –1,54 5,03
0,7 85 18,5 24 11,42 16,83 45 283,25 2025 –3,30 –0,19 –0,47 4,86
1,7 140 4,8 50,2 11,37 16,35 52 267,32 2704 –3,47 –0,14 –0,33 4,96
2,6 232 21,8 106 11,87 17,94 65 321,84 4225 –3,41 –0,11 –0,36 4,81
1,3 117 5,8 96,6 12,5 22,78 100 518,93 10000 –3,48 –0,1 –0,07 4,87
4,1 473 99 347 11,58 17,76 85 315,42 7225 –3,52 0,21 –0,38 4,31
1,6 133 20,1 85,6 11,56 17,41 30 303,11 900 –3,42 0,65 –0,19 3,65
6,9 809 60,6 745 11,92 18,1 60 327,61 3600 –3,57 0,85 –0,33 3,17
0,4 51 1,4 4,1 13,25 30 100 900 10000 –3,57 1,05 –0,24 2,87

4) 5) 6) 
Y X1 X2 X3 Y X1 X2 X3 X4 Y X1 X2 X3 

237 –2,24 154 106 75191 1,35 523 1,82 273529 –3,87 –0,16 –0,4 0,06
160 –1,16 115 88 75846 2,15 567 4,62 321489 –3,59 0 0 0 
75 –0,06 98 46 71307 1,18 429 1,39 184041 –3,71 –0,15 –0,79 0,11

203 –1,99 118 105 96309 1,94 580 3,76 336400 –2,99 –0,3 –1,54 0,46
63 0,02 28 56 58573 2,01 490 4,04 240100 –3,3 –0,19 –0,47 0,08
45 0,25 17 54 76526 1,56 492 2,43 242064 –3,47 –0,14 –0,33 0,04

113 –0,87 50 63 73115 2,08 541 4,33 292681 –3,41 –0,11 –0,36 0,04
121 –1,07 56 28 62707 1,94 482 3,76 232324 –3,48 –0,1 –0,07 0,01
88 –0,15 102 50 98326 1,56 599 2,43 358801 –3,52 0,21 –0,38 –0,08

110 –0,81 116 54 62715 2 487 4 237169 –3,42 0,65 –0,19 –0,12
7) 8) 9) 

Y X1 X2 X3 Y X1 X2 X3 X4 Y X1 X2 X3 
23 0,15 37 39 7 7 20 49 400 1991 13 92 90 
18 0,77 33 40 8 10 19 100 361 1992 17 82 85 
27 0,21 15 35 7 9 21 81 441 1993 23 86 84 
29 0,67 36 48 9 11 17 121 289 1994 29 79 69 
43 0,91 26 53 9 11 16 121 256 1995 34 96,7 90,9
23 0,54 24 42 8 11 18 121 324 1996 38 95,5 95,4
55 0,33 15 54 11 17 15 289 225 1997 43 102 103,6
47 0,97 33 54 11 14 14 196 196 1998 47 94,8 91,4
35 0,16 44 50 16 13 10 169 100 1999 53 111 117,4
38 0,04 34 53 15 18 10 324 100 2000 61 111,9 119,9
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10) 11) 12) 
Y X1 X2 X3 Y X1 X2 X3 X4 Y X1 X2 X3 
30 1,56 4 10 42 6 2 36 4 15,6 0,21 16 –2,12
35 2,18 2 13 5 1 6 1 36 27,7 0,44 31 –7,18
40 2,74 3 14 1 5 41 25 1681 34,1 0,5 35 –9,31
44 3,12 8 15 5 6 5 36 25 37,7 0,58 39 –10,6
45 3,66 7 18 8 5 2 25 4 41,9 0,62 44 –12,3
42 3,32 10 20 6 1 4 1 16 24,4 0,41 27 –6,15
48 4,09 15 23 5 5 3 25 9 21,3 0,39 23 –5,74
50 4,58 14 25 9 2 1 4 1 36,7 0,55 38 –10,1
55 5,11 10 27 3 6 8 36 64 24,2 0,40 26 –5,56
61 5,62 18 21 3 1 38 42 79 35,7 0,52 37 –9,88

 

Критичні значення F-розподілу Фішера залежно від числа ступенів 

свободи f1 і f2 при рівні значимості p = 0,05 

f2 
f1 

1 2 3 4 5 6 7 8 9 10 15 

1 161,45 199,50 215,71 224,58 230,16 233,99 236,77 238,88 240,54 241,88 245,95

2 18,51 19,00 19,16 19,25 19,30 19,33 19,35 19,37 19,38 19,40 19,43 

3 10,13 9,55 9,28 9,12 9,01 8,94 8,89 8,85 8,81 8,79 8,70 

4 7,71 6,94 6,59 6,39 6,26 6,16 6,09 6,04 6,00 5,96 5,86 

5 6,61 5,79 5,41 5,19 5,05 4,95 4,88 4,82 4,77 4,74 4,62 

6 5,99 5,14 4,76 4,53 4,39 4,28 4,21 4,15 4,10 4,06 3,94 

7 5,59 4,74 4,35 4,12 3,97 3,87 3,79 3,73 3,68 3,64 3,51 

8 5,32 4,46 4,07 3,84 3,69 3,58 3,50 3,44 3,39 3,35 3,22 

9 5,12 4,26 3,86 3,63 3,48 3,37 3,29 3,23 3,18 3,14 3,01 

10 4,96 4,10 3,71 3,48 3,33 3,22 3,14 3,07 3,02 2,98 2,85 

11 4,84 3,98 3,59 3,36 3,20 3,09 3,01 2,95 2,90 2,85 2,72 

12 4,75 3,89 3,49 3,26 3,11 3,00 2,91 2,85 2,80 2,75 2,62 

13 4,67 3,81 3,41 3,18 3,03 2,92 2,83 2,77 2,71 2,67 2,53 

14 4,60 3,74 3,34 3,11 2,96 2,85 2,76 2,70 2,65 2,60 2,46 

15 4,54 3,68 3,29 3,06 2,90 2,79 2,71 2,64 2,59 2,54 2,40 

16 4,49 3,63 3,24 3,01 2,85 2,74 2,66 2,59 2,54 2,49 2,35 

17 4,45 3,59 3,20 2,96 2,81 2,70 2,61 2,55 2,49 2,45 2,31 

18 4,41 3,55 3,16 2,93 2,77 2,66 2,58 2,51 2,46 2,41 2,27 

19 4,38 3,52 3,13 2,90 2,74 2,63 2,54 2,48 2,42 2,38 2,23 

20 4,35 3,49 3,10 2,87 2,71 2,60 2,51 2,45 2,39 2,35 2,20 
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2.3. Візуалізація молекулярних структур  

 
 

1) 2) 3) 
   

  

4) 5) 6) 
   

 

 

 
7) 8) 9) 
   

 

10) 11) 12) 
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2.4. Оптимізація молекулярних структур  

 

 
1) 2) 3) 

   

 
4) 5) 6) 

   

  

7) 8) 9) 

   

 
10) 11) 12) 
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2.5. Квантовохімічне моделювання бімолекулярної хімічної реакції 

 

1) CH3CHO + HCN → CH3CH(OH)CN 

2) CH3Br + NH3 → [CH3NH3]+ + Br– 

3) CH3Br + (CH3)3N→ [(CH3)4N] + + Br– 

4) CH3Br + (CH3)2NC2H5 → [(CH3)3NC2H5] + + Br– 

5) C2H2 + H2 → C2H4 

6) C2H2 + CH2=CH–CH=CH2 → C6H8 

7) C2H4 + CH2=CH–CH=CH2 → C6H10 

8) CH2=CH–CH=CH2 + CH2=CH–CHO → C6H9CHO 

9) OH– + CH4 → H2O + CH3
– 

10) OH– + CH3OCH3 → H2O + CH3OCH2
– 

11) CH3OH + Br– → CH3Br + OH– 

12) CH3Br + NH2
– → CH3NH2 + Br– 
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2.6. Моделювання кінетики хімічної реакції 

 

Кінетика кватернізації третинних амінів (b = 0,1 моль/л) бензилхлоридом 
(a = 0,1 моль/л); Cпр – концентрація продукта, моль/л 

1) Ph–CH2Cl + (CH3)3N 2) Ph–CH2Cl + (C2H5)3N 3) Ph–CH2Cl + (C4H9)3N 
t, c Cпр, моль/л t, c Cпр, моль/л t, c Cпр, моль/л

1620 0,0146 10800 0,0116 21180 0,0092 
3480 0,0226 11160 0,0116 86700 0,0254 
6660 0,0351 77040 0,0440 238860 0,0458 
10800 0,0423 103800 0,0500 341580 0,0531 
75540 0,0830 158580 0,0610 423000 0,0585 

4) Ph–CH2Cl + 
CH3(C8H17)2N 

5) Ph–CH2Cl + 
(C8H17)3N 

6) Ph–CH2Cl + 
(CH3)2C4H9N 

t, c Cпр, моль/л t, c Cпр, моль/л t, c Cпр, моль/л
3300 0,0138 1260 0,0030 240 0,0058 
6900 0,0247 2400 0,0051 600 0,0137 
11220 0,0342 3600 0,0071 900 0,0192 
15360 0,0403 7740 0,0121 4620 0,0463 
81600 0,0738 10800 0,0145 6600 0,0547 
Кінетика каталітичного розкриття оксиранового циклу епіхлоргідрину 

(s = 12,77 моль/л) оцтовою кислотою (CОК – поточна концентрація оцтової 
кислоти, моль/л) 

7) cat = (C4H9)3N,  
0,005 моль/л 

8) cat = (C4H9)3N, 0,0025 
моль/л 

9) cat = (C4H9)3N, 
0,00125 моль/л 

t, c 
CУК, 
моль/л 

t, c 
CУК, 
моль/л 

t, c 
CУК, 
моль/л 

0 0,201 0 0,201 0 0,201 
3600 0,192 14400 0,165 27000 0,151 
7200 0,181 25200 0,135 52200 0,109 
10800 0,173 34200 0,113 68400 0,093 
14400 0,163 51180 0,074 76200 0,080 
10) cat = (C4H9)4NI,  

0,005 моль/л 
11) cat = (C4H9)4NI, 

0,0025 моль/л 
12) cat = (C4H9)4NI, 

0,00125 моль/л 
0 0 0 0,196 0 0,196 

1200 0,015 4800 0,168 10800 0,169 
2400 0,028 9600 0,145 14400 0,157 
6000 0,057 14400 0,124 18000 0,151 
8400 0,078 18000 0,108 21600 0,141 
10800 0,102 22200 0,091 25200 0,130 
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РЕКОМЕНДАЦІЇ ЩОДО ОФОРМЛЕННЯ ЗВІТІВ 

 

Перебіг і результати лабораторних робіт оформлюються студентом у 

вигляді друкованого звіту, який подається наприкінці навчального семестру 

викладачеві. Оформлені роботи об’єднуються у звіт під єдиним титульним 

аркушем, із зазначенням дисципліни, курсу, групи та ПІБ студента (див. 

приклад нижче). Кожна нова робота має починатися з нового аркуша і 

включати в себе: 

 номер і назву роботи; 

 мету роботи; 

 покрокові завдання до роботи та відповіді на них (у послідовності 

“завдання – відповідь”); 

 висновок до роботи згідно із завданнями. 

За кожну лабораторну роботу виставляється оцінка у відсотковій шкалі 

та ECTS. Підсумкова оцінка за звіт є середнім балом за усіма роботами. 

Правильність і повнота виконання є визначними критеріями оцінювання 

лабораторних робіт. Робота вважається повністю виконаною, якщо: 

 у звіті наведено відповіді за усіма пунктами завдання до лабораторної 

роботи; 

 у звіті відображено усі зміни, які відбувалися з моделлю протягом 

виконання роботи, у вигляді скріншотів (знімків екрану); 

 висновок до роботи відображає її сутність і значення отриманих 

результатів, а також суб’єктивну думку студента.  

Для успішного захисту звіту з виконання лабораторних робіт студент 

має добре володіти матеріалом, поданим у теоретичній частині до робіт, і бути 

готовим відповісти на питання за ним. Для підготовки до захисту 

рекомендується відповідати на запропоновані у посібнику питання для 

самоконтролю після опанування теоретичного матеріалу та виконання роботи. 
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